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A composite is basically any video scene that requires elements from two or more separate video
clips or images to be combined into a single frame. A wipe transition is a composite, a title
overlay is a composite, and most special effects shots contain some degree of compositing.

In this chapter we'll learn how to create basic overlays, and how to fade clips in and out. We'll
also look at chromakey - where we use a blue screen to superimpose objects (and people) from
one shot into another. In addition, we'll go further, and add entirely computer-generated
creatures into a real video scene, and build a title montage from a sequence of still images.
Compositing may sound fancy when we talk about special effects and bluescreen, but many of
the best applications of compositing are when it’s used completely invisibly to solve shooting
problems, or create shots which would be too expensive or impractical to create in real life, and
this will be the last application we’ll cover.
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The starting point for any composite is the ability to create transparency. In order to get two shots
to merge together, you'll need to run them both at the same time on different tracks in the
timeline, then cut holes into the top image so that parts of the bottom one are seen through it.
The skill and ingenuity with which you layer your shots will define how effective and convincing
the final composite is.

Premiere contains some very nifty functions for building composites. These include a range of
keying tools - which allow you to automatically make parts of a video clip transparent based on
their color, or brightness. There are also sets of tools allowing you to make areas of the screen
transparent based on what are called mattes. Mattes are black and white images or video clips
which, when loaded into the transparency dialog let you replace all the black areas with one video
clip, and all the white areas with another. Grey areas produce a blend between the two images.

The result is a very flexible system for creating composites. However, this kind of effect is a whole
subject area in itself, and Premiere, although it contains some excellent tools, barely scratches the
surface of what's possible. Other packages such as Adobe After Effects, Discreet's Combustion, or
Pinnacle's Commotion are entirely dedicated to compositing, and as such contain a far greater
range of tools.

For example, in After Effects, you can fly objects around the screen in 3D, create animated masks
to cut one object out of a moving video shot, or use motion tracking to make composites from
moving camera shots. You can even write scripts to define the way an object will be animated
around the screen.

Other packages too can be helpful in compositing. A 3D design package will let you create and
animate objects which can then be brought into Premiere and included in your scenes. A program
like Macromedia Flash can also create animations suitable for compositing. However, probably the
most useful package you can add to Premiere for effects work is an ordinary still image editor -
like PhotoShop. With it you can draw mattes, create still images with transparency built into them,
and alter frames of video in whatever way you like.

In addition, if you are using Photoshop, there's another trick you can use to create a whole range
of effects – as long as you've got the patience. Premiere allows you to export portions of the
timeline as a filmstrip file. A filmstrip is simply a long, thin image containing every frame in your
video clip in sequence. This can be loaded into Adobe Photoshop, where you can work on each
frame as a still image. You can use any of Photoshop's tools to paint, clone, or alter your shot in
any way you like. It's time consuming and can be monotonous, since you have to alter every frame
of your scene by hand. However, for effects like painting lightning flashes onto a sky, cutting out
a figure who wasn't shot against a blue screen, or animating drawn images, it can be a real boon.
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If you're going to be doing a lot of this kind of work, however,
Photoshop really isn't the ideal tool. It may be worth investing in a
specialized video painting or rotoscoping package, like NewTek's
Aura.
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Shooting for compositing is a particular skill. You need to know exactly how your finished shot is
going to look while you're shooting the elements for it. This means getting the perspective, and
particularly the lighting absolutely consistent. It's important to keep the camera still because even
the slightest motion will have the effect of separating the two composited images, and destroying
the illusion that they're part of the same scene. Finally, if you're planning to superimpose an
element of one shot into another scene, you need to know before you shoot the scene exactly
how you plan to remove the background of your shot and separate out the objects to be
superimposed.

Once you have the basic skills, however, compositing can open up a whole new world to the
enterprising videographer. Some really stunning effects can be created with a little effort, and
common shooting errors, such as poor exposure or unwanted microphones in shot can be
corrected.

The simplest type of compositing is the overlay - where one video image is simply faded over
another. In this example, we're going to learn to fade in a title on a black background over a piece
of video, and animate its opacity in a much more complex way than you could achieve with a
simple dissolve.

1. Our title screen has already been generated using a still image package (Adobe
Photoshop). We could also have created it using any of the three titling plug-ins that
come with Premiere as standard (see the chapter on titling for details)
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Superimposing a Title Screen
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2. The footage over which we're fading the title is already on the timeline. We place the
title over the top of it, in a higher video track, and stretch it to cover as much time as
we like (because the title is a still image, we can alter its length as much as we want.

3. Click the triangle beside the label for the title track at the extreme left of the timeline.
This opens out the track so we can see the pink strip beneath it. This is where the
keyframes appear for animated visual effects, but it's also where you'll find the
rubberband that controls the opacity of your clip.

4. If you can't see the rubberband (the red line at the top of the pink strip), check to see
that the red button at the bottom left of the track is pressed in (so the track is in
opacity mode rather than keyframe display mode).
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Note - make sure the track you're using isn't Video 1A or Video 1B.
These tracks don't have an opacity rubberband.
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5. Click the rubberband at any point and drag down. A point appears, which lets you
control the opacity of the title image. At the bottom of the strip, the title is invisible, at
the top, it's fully opaque. You can place points anywhere on the clip. 

6. Here we've created a complex fading sequence where the title fades in about half way,
stays there for a few seconds, fades in fully to obscure the video completely, then fades
out gently. To see the results, we either hold the ALT key and drag through the timeline,
or render a preview of the effect.

Keying Effects
Making a whole clip fade in or out is easy enough. However, most compositing is a little more
complicated. In order to combine two or more video images into one, you'll need to be able to
make just a part of the top image transparent so that the bottom one shows through. For this you
need to create a key.

Keys can be based on color - so that you make a given color transparent – or on luminance –
where either the brightest or darkest part of an image is made transparent. Additionally,
transparency can be introduced using mattes.

To gain access to Premiere's advanced keying tools, you must right-click/control-click on the image
to be made transparent (usually the top shot in the timeline), and pick Video Options >
Transparency. 

Before we take a look at Premiere's keying options individually, there are a couple of points worth
mentioning about the Transparency window.
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Note: You can't make tracks Video 1A and Video 1B transparent.
The idea behind this is that however many tracks you put in, these
are considered as the very back of the screen, so there’s no point in
making them transparent.
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Whichever method of transparency you decide to use, you'll want to see how well it's working. The
sample image at the top right of the window lets you check the results of your work. You can zoom
into the Sample window by clicking on any portion of it, and zoom out by alt-clicking. You can
switch between moving around the image and zooming it by selecting one of the two icons (hand
and magnifying glass) at the bottom right of the sample image.

You can also create a basic matte within the sample window. The four corner points of the image
can be dragged so that parts of it are obscured. This is useful if you want to have just a portion of
the screen obscured by another image – for example a split screen, or superimposing a name
caption underneath an interviewee.

Below the image, a time slider lets you shift through your clip to check how your keying works at
any point during the shot.

Additionally, there are three buttons at the bottom left of the sample image. These let you choose
how you view the composite. The first lets you view your transparent clip against a white or black
background (useful if you want to see the contrast at its edges) the second displays the background
as a Photoshop-style chequered image (useful for seeing degrees of transparency in semi-
transparent objects) and the third shows you the final composite as it would look on the timeline.

Premiere includes 14 different types of key composite, which can be selected from the Key type
drop-down menu shown.

Chromakey

The basic color-keying tool. It's very effective, and has a range of options to refine the
transparency. Once selected, an image of your shot appears in the Color section of the window.
Click on a portion of it to define the color you wish to make transparent, then adjust the sliders
to get the best possible key. The controls are:
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Similarity – you don't usually want to just remove one single shade of the color – so
increase this slider to increase the range of colors which become transparent.

Blend – if the results of your chromakey aren't too good, you may want to reduce its
opacity a little, blending your image slightly with the background. Here you're simply
altering the opacity of the clip.

Threshold and Cutoff – these two sliders are used together to determine the way
shadows and areas of darker color in your transparent color are treated. By bringing
the two settings towards the right, shadows are preserved and increased – that way, a
shadow on a bluescreen can be preserved as a shadow in your composite. Moving them
to the left removes shadows making your blue-screen smoother and cleaner. 

Moving the Cutoff slider
to the right of the
Threshold slider can
have undesirable
effects, as it inverts the
effect of the shadow.

Smoothing

The Smoothing option
simply softens the edges
between the transparent
and opaque portions of
the image, smoothing
your two composited
images together.
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RGB Difference

A much simpler version of the Chromakey tool. Here, you select the color you want to key out,
and adjust the single Similarity slider to define how much of the image is made transparent. You
can't preserve shadows, and you can't get very accurate results on a poor screen. However, if
you're working quickly and have a well-lit backdrop (or if you're using a computer-generated
image with a perfectly smooth color from which to key) RGB difference is quick and easy.

Luminance

This creates transparency based on the brightness of each pixel in the image. Say you have a video
shot in which you've had to overexpose the sky in order to get the scene exposed correctly. This
happens all the time - especially when recording indoors where a window is in shot. By placing a
sky photograph on a lower video track, then using luminance transparency to key out the brightest
part of the video shot, you can seamlessly replace the overexposed sky with your photo creating
the impression of a perfectly lit shot.

Luminance keying has two adjusters, Threshold and Cutoff. Put simply, if the Threshold is to the
right of the Cutoff, then dark areas are being made transparent, and if the Cutoff is to the right of
the Threshold, lighter areas are being removed. The closer together the two sliders are placed, the
sharper the definition of the key, and the harsher the blend between transparent and non-
transparent areas.

Alpha channel

Some types of image file are capable of storing alpha channels. These are simply maps to define
which areas of an image are transparent (and how transparent they are). Alpha channels can be
created using Photoshop, and a range of other packages, and are then saved along with some
image files (for example GIFs). Their advantage is that they can be created very carefully in
advance, and turned on or off at will. This means that you can cut out the objects you're intending
to composite in another package, then import them into Premiere without worrying about how
you're going to key them.
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Alpha keying is suited to still images, but not so suited to motion video where creating your alpha
channel in the first place can be a time consuming and difficult job.

Black and White Alpha Mattes

Usually used for superimposing titles which have either a black or white background and a certain
type of alpha matte (a pre-multiplied alpha matte) which a few image formats create. Mostly,
however, you can get just as good a result using other transparency methods.

Transparency and Compositing 0099

:241

0497_09idx  13/12/01  2:18 pm  Page 241



Image Mattes

A very useful matte which allows you to decide exactly which parts of your video clip are made
transparent - not by any aspect of the video itself, but by loading in a completely separate black
and white image which you've created to define the shape of the transparent areas.

Say you're doing a title sequence, where you have an animated backdrop, and you want to lay your
title over it in the shape of burning fire – as though the words are cutting through the backdrop
to show fire behind it. You'd place the fire and water onto the timeline, and make the top (fire)
clip transparent using an image matte. In the Matte > Choose… section of the window, you'd load
in your title as white words on a black background. Premiere would then replace the black areas
(the background) transparent so the water showed through, and replace the white areas (the
writing) with the fire clip.

Difference Matte

This lets you load in a still image or video clip which it then compares to the transparency clip pixel
by pixel. Only those parts of the image which are the same in both images are kept solid. Those
that are different are made transparent.
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The difference matte is most useful when used in reverse (with the Reverse Key button selected).
That way, you can isolate just the part of a video clip which changes during a shot. Say you've got
a locked off camera shot, of a street, and you drive a car through it. By loading the shot in, using
a reversed difference matte, and bringing in a still frame of the empty street as the matte, you
should be able to make everything but the car transparent, and you can then place that moving
car into another scene. 

That's the theory, but in practice, most video cameras introduce a lot of noise to an image, so
unless you have a very well lit simple shot and there's plenty of contrast between the object you
want to isolate, and the rest of the scene, Difference mattes can become quite dirty with parts of
the original background flickering in and out.

Blue-Screen and Green-Screen

If you're working with blue or green screens which are brightly lit and correctly colored, you can
get very good clean results from a blue/green-screen key. You could simply use chromakey here
as we did in the example at the very start of the chapter, but blue and green screen mattes can
produce better results – especially where you're keying transparent objects like glass or hair, or
where you want to preserve shadows on the background.

The only two sliders here are Threshold and Cutoff. Start by dragging the Threshold to the left until
the screen becomes entirely transparent. This often makes the foreground start to become a little
transparent too, but sliding the Cutoff to the right should bring it back, defining the edges of the
matte more sharply.
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Be careful not to take the Cutoff slider past the Threshold one, or the mask will become inverted
the background will be visible, and the foreground will become transparent. 

Multiply and Screen

These two transparency settings create ghostly effects by working in the same way as the Multiply
and Screen settings in Photoshop. Images are made transparent based on their own luminosity and
the luminosity of the image underneath. The result is either a brightening effect in the case of the
Screen option, or a darker image in the case of Multiply.

Track Matte

This is similar to the Image matte setting, but allows you to use a moving image to create the
composite. It's often used where a black and white matte video has been created by another
package with better keying tools than Premiere, or where 3D animations have been produced with
matte clips for compositing. This allows you to create very clear and realistic composites.

Track Matte (or Travelling Matte) is the only transparency setting which requires three timeline
tracks: The bottom one holds the backdrop into which the composite will be placed, the middle
contains the foreground - the clip to be matted in - and the top track contains the matte itself. To
create the effect, the track matte transparency is only applied to the middle clip.

Non-Red

If you don't have any luck with the blue or green screen keys, try the Non-Red key. This works in
pretty much the same way, but lets you blend out the background color for a softer key. It can
also improve the edges of an object where the getting a good key is most difficult.
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Color keying is the basis of much compositing work. Here, we're going to use the basic blue-screen
tools of Premiere in a well-lit professional studio. The backdrop has been painted evenly, with a
light-catching paint, and we should be able to expect very good results.

1. We drop our background onto the timeline. We're using a still image - in this case it's
one generated in a computer. This is an environment our actor could never be placed
into in real life, so compositing is the only way to do it.

2. Next comes the blue-screen shot itself. We place this onto the timeline directly above
the background shot. When we do our effect, all the blue in this scene will be replaced
by our computer generated image.

3. Right-clicking on the top clip, we select Video Options > Transparency. We then choose
Blue Screen from the drop-down list. Instantly, we get a pretty good key. Most of the
background has vanished, and our actor is in place.
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Creating a Basic Color Key
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4. It's not perfect, though. We zoom into the sample window, and can see where the
shadows aren't well handled (to zoom in, just click on the image - to zoom out, alt-click.
To move around, select the hand icon at the bottom right of the image).

5. If we scrub through the shot with the slider beneath the image, we can see there are
moments when the key isn't at its best.

Dragging the Cutoff slider to the right darkens our foreground, and increases the
shadow. Dragging the Threshold slider to the left increases the pixels it treats as blue -
thus eating away at the edges of the foreground image. We experiment to find a happy
medium where the image blends most realistically. 

Now we know how to quickly put together a realistic blue-screen shot with fairly good studio
material, let’s have a look at what we do when dealing with slightly poorer source material.

It's rare to get the opportunity to work with perfect blue-screen material. Usually it's either badly
lit, or covered in shadows, or the blue-screen itself is unevenly colored. Here we have a particularly
poor example, and it's been left up to us in the editing suite to rescue it. What's more, the object
we need to key is glass, so we want to maintain its transparency.

1. We can see from the start that this is going to be a job. The blue screen is not only badly
lit, it's also poorly framed, so bits of the wall behind it are visible in shot. What's more, it's
not even a proper blue screen anyway - it's just a piece of blue cloth that happened to be
lying around.
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Rescuing a Poor Key
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2. We select Transparency, and try out a chromakey matte. The result isn't encouraging.
We can see the smudges and marks on the screen as well as the thick black line around
our subject. This clearly isn't going to work.

3. The Blue Screen option is better at handling transparency than Chromakey. This gives
a better result, but there are still problems. Each keying job is different, and presents
different problems. In this case, Non-Red turns out to be the best method.

4. Slowly, we reduce the Threshold, and the background begins to fade in. We now bring
the Cutoff value up a little way towards the Threshold. This increases the contrast in the
shadows, bringing them out - which is good because the dark areas of the glass become
denser. However, it's also bad because the shadows on the screen are also emphasized.

5. The glass slowly strengthens, and we have to make a compromise between the re-
appearance of parts of the blue background, and the transparency of the glass.

6. Switching the Sample image to a chequered background, and zooming in lets us see
exactly what's happening.
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7. To soften the edges of the mask, we turn the Smoothing function on. This blends the
edges between the transparent and opaque parts of the image. 

8. We now increase the Blend setting to full. This doesn't change the image much, but it
removes the blue coloring from the glass, making it appear more real.

The key is now as good as we can get it, but we still have the problem of the shot's
edges. As you can see, the edge of the backdrop is clearly visible, and we can't allow
that in our composite. We need what is known as a garbage matte - a mask which is
used to cut out an unwanted portion of the screen. 
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9. Luckily, the edges are quite a simple shape, and we can easily get rid of them. Move to
the sample area of the transparency window, and drag the four points at the corners in
slightly towards the center.

10. These points define a primitive mask which we can use to cut out the borders of our
image. It's not a very flexible mask, but for our purposes it's fine – we can just exclude
the unwanted edges of the shot. If we wanted a more complex garbage matte, we'd have
to generate it as a blue shape in a still image package, then import it, and do two
separate keys on our shot.

We've done our best to improve the mask. At the end of the day, you have to work with what
you've got, and if the material isn't shot properly to begin with, everything else is compromised.
Specialised compositing packages like After Effects can help a little, but your result will only ever
be as good as the image you start with. However, we’ve seen how you can cope with the inevitable
problems with shooting conditions you’ll encounter in your video career.
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Lighting for Compositing
If you're shooting for any kind of compositing work, you need to make sure you do the job
properly. As we've seen, Premiere can produce some very good keying results, but it needs a little
help from the director. Here are a few tips:

Size matters. The bigger your blue-screen, the harder it will be to light evenly. Film studios often
create massive chromakey backgrounds so they can do wide shots. However, they need to use
dozens or hundreds of lights to get an acceptable key.

Beware however, of making your screen too small. A small screen means your actor (or whatever
you're keying) needs to be placed very close to the screen in order to make the backdrop fill the
camera viewfinder. This increases the problem of light spillage, and often allows light reflected
from the backdrop to fall onto the keyed object - thus making parts of it prone to becoming
transparent.

Use a bright, pure blue (or green) for your screen. Darker colors tend to reproduce less well on
camcorders, and you'll have a harder job lighting it correctly. The closer the backdrop is to pure
blue, the more easily you'll be able to use blue-screen keying.

A bluescreen backdrop needs to be evenly and thoroughly lit. It needs to be made from a smooth,
and even material, and it needs to be kept flat. Spend some time looking at your backdrop to try
to detect shadows and lighting changes.

Even if you don't notice them, the chances are that the camera and the chromakey software will,
so if you can, use a light meter.
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Here's the minimum lighting set-up – two lights are positioned at 45 degrees to the backdrop.
They're positioned so that the light just about overlaps so there are no unlit areas and no hotspots
of bright light.

The lights are often covered with diffusing material to de-focus their beams, and pointed slightly
away from the backcloth so that they don't overexpose parts of it.

Once the backdrop is lit to your satisfaction, you can start to light your subject. If you have enough
lights and a big enough backdrop, always try to make sure the two lighting set-ups are as separate
as possible. If light spills from the backdrop to the foreground you'll get blue light on your subject.
If light spills from the foreground to the background, you'll get highlights on the back-cloth
creating a wider range of shades in it.

Sometimes it's desirable to have shadows cast on the backdrop. In a weather forecast, for example,
it often makes the whole thing more natural looking if the forecaster's hand casts a shadow on the
map superimposed behind them. Similarly, in a drama, it helps to make your subject appear a part
of the scene if they cast a shadow. 

On the other hand, it's not going to look particularly good if you're compositing a model aeroplane
into the sky to have a shadow cast onto the empty air. Decide whether you want shadows, and
where, and light accordingly.

Remember when lighting your subject that usually, you're lighting it to copy an existing
environment. It's not enough to have your subject well lit - they have to be well lit to blend into
the environment you're placing them in.

There's no point creating a dark, moody lighting set-up for someone who's going to be placed into
a bright sunlit day. And there's no point in doing a flat studio lighting set-up for a character who’s
about to be placed into a rocky cavern.
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Try to use a backlight. It often helps to put at least one bright light between the subject and the
screen, facing towards the camera. Position it so that the edge of the subject is lifted slightly, and
separated from the background.

This helps to give the subject a clear outline which will aid the keying process later on. Hair and
fluffy clothes can be particular problems in keying, but if they're illuminated well, it's easier to get
a good effect.

When it comes to shooting, there are a few important rules to follow. The most significant is that
the camera needs to be mounted on a sturdy tripod.  When shooting for compositing, you need
to make very sure that the camera remains absolutely still. You can't zoom. You can't pan. You
can't tilt. And you can't track. A composite by definition involves blending two shots into a single
image. This means that if the camera moves - even by a millimetre - in either shot, the foreground
and the background will appear to part company, it will become instantly obvious that they're not
part of the same shot, and the illusion will be lost.

Also, make sure that all of the automatic camera functions are turned off. Just as moving the
camera destroys the illusion of your composite, so any other automatic function will also ruin
things.

Automatic focus – although useful in most circumstances, it will be disastrous if your
foreground subject keeps dipping in and out of focus while the objects you composite
around them remain rock steady.

Automatic exposure and color balance are also to be avoided. You don't even notice
them most of the time when shooting normal footage. However, if your subject
becomes suddenly brighter or darker, or changes color whilst everything else remains
unmoved, the effect is going to fail.

Finally, do make sure that your foreground subject doesn't contain any of the same colors you're
using for the backdrop. If you're shooting an interviewee against a blue background and they're
wearing a blue tie, the tie will disappear, and you'll be left with a wide transparent stripe down the
middle of their chest. This doesn't look good on anyone, especially not the camera operator who
failed to notice it. Nor does it make things easy for the video editor who has to work with that
footage!

We've now got a basic idea of the way compositing works, and we've had a go at a couple of
bluescreen composites bringing one element into another shot. Now let's take things a little
further by creating a montage of the type you'd see in a title sequence. We'll be using several still
images and a video background to produce an intro for a program about the environment…
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1. Using Photoshop we produce our still images. Here we've taken an image which needs
to be cut out. We don't want the background, just the fossil against a transparent
background. We can use soft-edged transparency without any keying problems because
we're saving our images as Photoshop files which Premiere can directly load.

2. We could create all our elements as separate images ready to be combined in Premiere,
but we don't. Instead, we make them as layers in a single Photoshop document - that
way, we can scale and position each element to compose the scene much more easily.
We can turn individual layers off and on to see how our shot is built up.
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Compositing with Still Images
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3. When we turn to Premiere, we can load in each Photoshop layer as a separate image.
It's a bit of a pain because there are a lot of layers, but we've got the composition of
the piece sorted out already. 
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4. When we double-click on an image to view it, we notice that it already has transparency
- we can switch between the RGB view, and the Alpha view (in which we can see how
the transparency is stored). We don't need to do anything to composite the shot.
However, we do need a few more video tracks. Right click on the timeline, and select
Track Options, then add 3 more video tracks.

5. We start by putting in our background. This is a video shot of an ocean. Over the course
of our title, we place it on track Video 1A.

6. Next we start placing our images. We select the first image and drop it onto the timeline
on track Video 2. Scrubbing through whilst holding the ALT key lets us see the
composite. It looks OK, so we click the triangle to the left of the video track and open
the Opacity bar. We now drag the red line at appropriate points so that our image fades
in, remains on screen for a few seconds, then fades out (see the first tutorial of this
chapter).

Transparency and Compositing 0099

:255

0497_09idx  13/12/01  2:18 pm  Page 255



7. We place the next shot on top of the first, but make it fade in just before the first
creature fades out. For this one, we'll be a little more adventurous. Right click, and go
to Video Options > Transparency. Although our shot's already transparent, we can still
add another type of key. We choose screen keying, and the creature now appears
lightened and translucent. 

8. We now place in a few more images, making them appear and disappear throughout
the intro. Feel free to experiment with different opacity settings and transparency
methods. You can even try using a few image filters to add interest to the shots.

9. Finally, we want to add some interest to our backdrop. Right now it's just an ocean
scene - which is nice enough, but not very active. We bring in a fire video – which the
director has asked us to include to symbolize damage being done to the environment...
or something.

10. We place the fire between the ocean video, and the images we've placed over it. It's
been shot against a black backdrop so right now we can't see the back layer. Bringing
up the transparency window, we add a Luminance key. 

11. We play around with the Threshold and Cutoff settings until the black areas are
removed. Now when we render a preview (by dragging the yellow bar at the top of the
timeline to cover our shot and hitting return) we can see the fire burning, with the
background visible behind it.

0099 Revolutionary Premiere 6 

:256

0497_09idx  13/12/01  2:18 pm  Page 256



12. The only remaining job is to fade the scene out at the end. We drag a cross-dissolve
transition from the Effects window onto the transitions track at the end of our shot, and
use File > New > Black Video to create a black image. We drop this onto Video 1B,
overlapping it with the dissolve, and the sequence is complete.

Now we’ve used our new-found techniques to composite some still images in Premiere, let’s turn
our attention to a pretty ambitious moving sequence!

Track mattes or traveling mattes use two separate video clips to composite one image with
another. They combine the high degree of control available with image matting with the animation
ability you get with color keying. In this example, we're going to show just how convincing a
traveling matte can be.

1. Using a 3D package (3D Studio Max) we've created an animated creature. It's been a
major job, and the result is a pretty realistic looking animal. It's been textured with
appropriate skin colors, lit, and animated to move realistically with an invisible skeleton.
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2. We could render it out against a blue background, and use chromakeying. This would
work OK, but not brilliantly. Our creature has motion blur added to it, so the
chromakey would have had trouble dealing with the transparency of the blurred parts
of the object.

3. Instead, we render it as two separate video sequences. The first is a simple image of the
creature. We've drawn it against a black background, but the color of the background
really doesn't matter. The second clip is the same animation, but as a matte. The
creature is completely white, the background is black, and the blurred edges are
represented in shades of grey.
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4. We import this creature and its matte into Premiere, and also bring in the backdrop
we're going to be compositing it into. This is a straightforward locked off camera shot
of some empty countryside which we drag and drop onto the timeline.

5. Right-clicking on the timeline, we add another video track to accommodate our effect,
and place our two creature shots onto the timeline. The matte is placed in the top track,
and the creature itself is positioned directly underneath it.

Transparency and Compositing 0099

:259

0497_09idx  13/12/01  2:18 pm  Page 259



6. We need to make sure that the two shots are lined up perfectly – if they're even a frame
out, then the "hole" produced by the matte layer won't be directly over the creature,
and we'll get a very unrealistic composite.

7. When we're happy with the positioning, we right-click again and choose Video Options
> Transparency. In the Transparency window, we pick Track Matte as our transparency
method. There are no other settings to be made here, so we close the box.

8. Dragging the work area (the yellow strip at the top of the timeline) to cover our effect,
we hit return to create a preview of our effect. After a minute or so it has rendered,
and the creature looks pretty good in its new environment. 

9. There are still a couple of things we can do to improve it, however. The first is to add
another matte. This is a mask we've created in Photoshop. It's a transparent image
made from the original landscape. We've rubbed out the top part of the picture, but
left in the foreground bushes. We simply want to lay this over the feet of the creature
to make the shot more realistic.

10. When we add yet another video track to the timeline, and drop this image into it,
expanding it to cover the length of the effect, we can see the point of our effort. Now,
instead of appearing to have been dropped in over the top of our shot, the beast is
actually in the landscape, bushes are growing in front of him and behind him, and he
really appears to be part of the scene.
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11. Because the new layer has been made from a still taken from the old background, it
composites with it perfectly without any messing about. Importing it in Photoshop
format meant that the transparency was preserved. We could have exported it with a
matte and composited it in that way, or used alpha matting if it had been a different
type of file.

12. There is still more we can do to improve the shot. The monster's lighting, contrast, and
color balance levels are perfect because it's been created in a virtual world.
Unfortunately, our landscape has not. To truly blend in, the creature will need to be
color corrected to its surroundings.

13. We add a brightness and contrast filter (from the Video Effects window, under Adjust)
to the creature, and pull down its contrast so that the absolute black in its shadows is
faded to the level of the darkest point in the real world image.

14. Now, we add a color balance filter to give the creature more of a green/blue tint so
that it better matches its surroundings.
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15. Finally, we drop in a very slight blur. No video camera is perfect, and the shot we have
is slightly softened. The creature, on the other hand is so perfectly pin-sharp that it
appears too computer generated. The blur filter just softens it enough to blend it into
the real world. The result would fool anyone but a paleontologist.
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Sometimes, as we’ve seen, a composite is supposed to be noticed – it's there to make a splash, or
create an effect you couldn't otherwise do. But often, however, you need to create a composite
which nobody notices. In our last tutorial we want to do two things – correct a mistake, and alter
a landscape...

1. Our first job is to change a landscape. The scene is for a sci-fi drama. The view of
London needs some extra buildings. It's a still camera shot, but the image is a moving
video image, and later, an actor appears at the right of the shot, so we can't just work
on it as a still

2. That said, there's no reason why small parts of the image can't be still images –. we
export a single frame to a photo editing package (Photoshop in this case). Here, we start
to make our changes.

3. Using the clone brush, we paint in images of some buildings we've constructed in a 3D
application. A little softening with the airbrush gives the impression that they're
receding into the clouds.
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4. With the scene looking as we want it, we cut around our new additions. We add another
layer to the image, and move our shot onto the top layer so that we can create a
transparent background. We then use a soft eraser to rub out everything but the
buildings and a small area around them.

5. Now we can import this image back into Premiere, and place it on the timeline over
our original scene. Most of the shot is moving – the clouds still roll, and the trees sway,
and the actor can walk into shot, but the newly added elements still look like they're
an integral part of the shot.

This next shot contains a very common problem. This scene was shot next to a window.
The camera couldn't handle the difference in lighting between the outside and interior.
Hence, when the exposure is correctly balanced for the actors, the window appears as
an overexposed white rectangle.
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On the other hand when the scene was re-shot using the correct exposure for the
window, the actors can't be seen. We're going to use a matte to combine the two shots.

6. First we export a still image to Photoshop. We use this to create a soft edged mask – a
black and white image where the window area is completely black, and the rest of the
shot is white. We use a soft-edged brush to paint this so that when we composite, the
edges of our mask will be invisible.

7. Going back to Premiere, we place our two shots on the timeline - one directly above
the other – and open the transparency window. For our Key type, we choose Image
Matte.
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8. Clicking the Choose… button at the top left of the window, we locate our black and
white matte, and load it in. Depending on which version of the scene we've placed in
the top track, we may need to click the Reverse Key check box (to avoid ending up with
the worst aspects of both scenes).
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Looking at the monitor, we find the shots are now combined. The well-exposed window is
seamlessly integrated into the well-exposed room shot. Nobody need ever know how difficult it all
was! 

This technique can be used to remove boom mikes, or unwanted passers-by. Try using it to bring
several versions of the same actor into one shot. This kind of matting works well until somebody
tries to walk across the shot – as soon as anything tries to cross the line of the mask, it will vanish.
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Summary
You’ve now seen how to implement the most common kinds of compositing effects in Premiere,
and also how you can shoot your footage to help them along a bit.

We’ve covered:

Basic superimposing with titles

Keying effects

Managing keys and enhancing poor ones

Special lighting tips for bluescreen and chromakey

Traveling matte effects

Using invisible masks

In the next chapter, we're going to look at how you can add professional looking effects to your
movies.
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